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Section 1 Enrollment with Vermont Medicaid 
This guide is for nurses who are independently enrolled with Vermont Medicaid and providing 
services to Medicaid beneficiaries authorized services under the High-Tech Nursing Program. It is 
not intended for services provided through a Home Health Agency.   

Thank you for your interest in becoming a Green Mountain Care healthcare professional. Provider 
participation is vital to the successful delivery of services to our Medicaid members. We welcome 
your application. 

With our online Provider Management Module, enrolling in Vermont Medicaid is fast and efficient. 
You are no longer required to submit paper application forms and supporting documentation. This 
can all be done online, tailored to your provider type, streamlining the process. This online 
process decreases the time you spend on filling out forms as well as decreasing the overall 
processing time of your application. To learn more about Vermont Medicaid’s online Provider 
Management Module, please visit http://www.vtmedicaid.com/#/home. 

In accordance with Section 6401 of the Affordable Care Act of 2010 (ACA), all enrolled and newly 
enrolling providers will be subject to federal screening requirements. State Medicaid Agency 
requirements are available for review at https://www.cms.gov/Medicare/Provider-Enrollment-
and-certification/MedicareProviderSupEnroll/ProviderEnrollmentRegulation.html 

Please visit the Provider Management Module at https://vermont.hppcloud.com/Home/Index/.  To 
begin a new enrollment or to re-enroll, click Menu on the top left-hand corner of the screen. Select 
Provider Enrollment and then New Enrollment. Select independently billing Hi -Tech nurse. 

Select provider Type of T36 S22 for Registered Nurses and T36 S23 for LPN’s. The Provider 
enrollment team is available to assist at 802.879.4450, Option 4. Additional resources to help you 
enroll can be found at http://www.vtmedicaid.com/#/provEnrollResources. 

Once you have been enrolled and have a provider # with Vermont Medicaid, you will need to look 
at the options for billing and the various requirements of each option.  

http://www.vtmedicaid.com/#/home
https://www.cms.gov/Medicare/Provider-Enrollment-and-certification/MedicareProviderSupEnroll/ProviderEnrollmentRegulation.html
https://www.cms.gov/Medicare/Provider-Enrollment-and-certification/MedicareProviderSupEnroll/ProviderEnrollmentRegulation.html
https://vermont.hppcloud.com/Home/Index/
http://www.vtmedicaid.com/#/provEnrollResources
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Section 2 Billing for a Vermont Medicaid Member 
The follow codes should be used when billing Vermont Medicaid. Please remember billing is done 
in 15-minute increments on CMS 1500 form or electronic claims forms. 

Code Modifier RN/LPN Shifts  

Per 15 minutes   Rate Per 15 Minutes 

T1002 None RN Day $9.95  

T1002 UJ RN Night     $10.94  

T1002 TV RN Holiday/Weekend $10.94  

T1003 None 
LPN 
Day                                                      

$8.45  

T1003 UJ LPN Night $9.30  

T1003 TV LPN Holiday/Weekend $9.30  

Hours worked should be documented where services are rendered in order to meet audit criteria. 
Units billed must correlate with the hours documented.    

Billing typically occurs after the end of the week services are provided. Claims must be submitted 
within 180 days of date of service. When submitting a bill, you will need to do each of the 
following:  

1. Make sure you have and retain documentation of hours/units worked. 

2. Submit a claim for units of treatment services to DXC.  

Many options exist to bill Vermont Medicaid: 

• Contract with a Vendor to do billing  

• Use DXC’s free software, PES 

• Submit a Paper claim  

 Paper Claims 

If you want to bill on paper, no trading partner account is needed. You may simply mail your 
paper claims to DXC. Please note that paper claims do require additional processing time; 
electronic claims are able to be processed and paid more quickly.  

• Full instruction for paper claims, go to the Vermont Medicaid website:   

http://www.vtmedicaid.com/assets/resources/CMS1500Presentation.pdf  

Proper coding must be adhered to use of CPT coding books and consultation with Provider office 
on diagnoses codes maybe helpful.  

http://www.vtmedicaid.com/assets/resources/CMS1500Presentation.pdf
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 Electronic Claims 

If you want to bill electronically (PES or other software), you need a trading partner account.    

• You may also get DXC’s free software, PES, if you would like 

 Trading Partner Account 

1. Go to http://www.vtmedicaid.com/#/home and click on Information, HIPAA Tools  

2. Print and fill out and sign the Trading Partner Agreement and EDI Registration  

3. Mail the documents in (the address is on the back of the Trading Partner Agreement) Once 
DXC receives your documents, DXC will:   

a. Create test and production accounts  

b. Send back a package on how to proceed (which include instructions about 
downloading and setting up PES if that is what you choose to use)  

If you have questions about filling out the paperwork, please call DXC’s EDI Coordinator at 1-802-
879-4450, option 3. 

http://www.vtmedicaid.com/#/home
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Section 3 System Set-Up for Electronic Claims using PES  
 Equipment Requirements  

Provider Electronic Solutions is designed to operate on a personal computer system with the 
following equipment requirements:  

  

Minimum  Recommended  

Windows 98/2000/XP  Windows 2000 or Windows NT or higher  

64 Megabytes RAM  128 Megabytes RAM  

800 X 600 Resolution  1024 X 768 Resolution  

9600 Baud Rate Modem or faster  9600 Baud Rate Modem or faster  

WinZip  WinZip  

 Provider Electronic Solutions Software Media  

The Provider Electronic Solutions application programs and files are located on the Vermont 
Medicaid web site at www.vtmedicaid.com/#/pes.  

 Program Installation  

The Provider Electronic Solutions application was designed for installation on the PC hard drive or 
to a network. To simplify installation, an automatic installation program is included in the 
download. Your computer must have WinZip in order to install the software. The instructions are 
as follows:  

3.3.1 Step 1   

Access the web site listed above. Use the filter option “Type” and select “Full Install” to view only 
the Full Install files. Click on 2.xx Full Install.   

3.3.2 Step 2   

The file will be saved to a temporary file on your PC. When the following screen is displayed, 
double click on the file titled “VT_V02xx_setup.exe”. This will begin the install and automatically 
proceed through the process.  

  
  

  

  

   

http://www.vtmedicaid.com/#/pes
http://www.vtmedicaid.com/#/pes
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3.3.3 Step 3 

Select Next at the Welcome screen. See Figure 3 

 
Figure 3. Welcome Screen 

3.3.4 Step 4   

At the Setup Type screen, highlight TYPICAL or WORKSTATION and select the Next button. Most 
installations will be a typical installation. See Figures 4a and 4b for details. 

 

Figure 4a. Setup Type screen showing the description of a Typical setup.  
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The Typical installation installs all of the files, including the database. This installation is used to 
install to a stand-alone PC, or initially to a network server. 

 
Figure 4b. Setup Type screen showing the description of a Workstation setup. 

The Workstation installation is used for all additional PCs that are connected to a network server 
where all users share the database. The initial installation of Typical to a PC has been completed 
as noted above. This installation type does not load the database files to the PC; however, it does 
allow for sharing the database files that were installed to the network.  
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3.3.5 Step 5   

At the Choose Destination Location screen, see Figure 5, select Next to install to the default 
directory, C:\vthipaa. If the software on the PC is to run from a network rather than the PC hard 
drive, select the appropriate destination drive. 

 
Figure 5. Choose Destination Location screen 
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3.3.6 Step 6 

At the Choose Database Destination Location screen, see Figure 6, select Next to load the 
database in the default directory, C:\vthipaa, or select the appropriate destination drive for 
installing to a network. 

 

Figure 6. Choose Database Destination Location Screen. 

  

3.3.7 Step 7   

At the Information screen, select OK, see Figure 7. As stated on this screen, note the drive and 
directory where the files were installed. The system will then install the program files. 

 
Figure 7. Information screen. 
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3.3.8 Step 8   

At the InstallShield Wizard Complete screen, select Finish to complete the setup. See Figure 8. 

 
Figure 8. InstallShield Wizard Complete screen. 

There will be an application folder placed on your desktop titled VT DXC Technology Provider 
Electronic Solutions. At this time, you may close the WinZip window. 
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Section 4 Submission of claims using PES   
 Signing On 

To access the Provider Electronic Solutions application: 

4.1.1 Step 1  

Double click the application folder from the desktop and then select DXC Technology Provider 
Electronic Solutions or select the Start button in the bottom left-hand corner of the PC, then 
select the Program option and then select “VT DXC Provider Electronic Solutions” and then “VT 
DXC Provider Electronic Solutions”. 

4.1.2 Step 2  

Once the option is selected, the Logon screen appears. The default User ID is “pes-admin” and 
the default password is “eds-pes”. 

Note:  The first time you log on you will be prompted to change the password. If this is your first 
log on, proceed to Step 4. 

 
Figure 9. Logon screen 

4.1.3 Step 3  

Select OK. 

 

Figure 10. Password Expired dialog box. 
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4.1.4 Step 4  

Enter the old password and then enter a new password twice. The software has a feature to allow 
for password reset beginning with version 2.14. Click on the drop-down arrow on the Question 
field and select one of the questions listed. Enter the appropriate answer in the Answer and Rekey 
Answer fields. Select OK. A dialog box displays a message stating whether or not the update was 
successful. 

 
Figure 11. Logon screen showing the Change Password fields. 

4.1.5 Step 5  

Select OK if the update was successful. 

 
Figure 12. Logon Status dialog box 
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4.1.6 Step 6  

If this is your first logon, the system will display the message shown in Figure 13. Select OK to 
update personal options. The Options dialog box will display. 

 
Figure 13. Application dialog box showing login status. 

4.1.7 Step 7  

Select the Batch tab. This information is necessary for connecting with the web site for uploading 
and downloading files. All fields are required, however, only one Communication Number and 
Qualifier is needed. Please note that the Web User ID is the same as your Trading Partner number. 

Note:  In addition, the password below must match the password you created on the web 
site. 

 
Figure 14. Options dialog box showing the Batch tab. 
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4.1.8 Step 8 

Select the Web tab. This is pre-set to use the Internet Explorer Settings on your PC. You will need 
to change the Environment Ind to A for submitting an acceptance test. Once you receive 
confirmation from DXC that the test was successful, you will need to change the Environment Ind 
to P. 

 
Figure 15. Options dialog box showing the Web tab. 

4.1.9 Step 9 

Select the Modem Tab. If your PC has a modem, select the Detect button on the Modem tab. If 
the modem is not automatically detected, find the modem information by selecting the Start 
button from the bottom left corner of the desktop screen. Then select Settings and Control Panel. 
Depending on the version of Windows the next option is either Modems or Phone and Modem 
Options. 

The Modem Tab must be completed even if no modem is present on the PC. In this case, place the 
cursor in the Modem Type field to access the modem listing. Select Generic Configuration, for 
most modems. 

 
Figure 16. Options dialog box showing the Modem tab. 
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4.1.10 Step 10  

Select the Interactive tab. Verify that the Modem Init String field is populated from the modem 
type selected on the Modem tab 

 
Figure 17. Options dialog box showing the Interactive tab. 

4.1.11 Step 11  

Select the Carrier tab. This information is necessary for the submission of the transactions. 
Choose the transaction type by selecting it at the bottom of the screen. It will highlight in blue. 
Using the drop-down arrow, select the carrier type with a phone number appropriate for your 
area. If there is not a local number available, select one of the toll-free numbers. Update the DTR 
(modem speed) to the appropriate speed to match your modem. You will need to set the X12 
Production/Test Indicator to T for submitting a test. Once you receive confirmation from DXC that 
the test was successful, you will need to change the indicator to P. 

Transaction Type Interactive is used for Eligibility Verification and Claim Status Request when you 
want an immediate response. Transaction Type Batch Transmit is used for submitting claims. 

 
Figure 18. Options dialog box showing the Carrier tab. 
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4.1.12 Step 12  

Select the Retention tab. This tab lists options for file storage and archiving. 

 
Figure 19. Options dialog box showing the Retention tab. 

Note:  The Payer/Processor tab has been completed for you. No entry or change is necessary to 
the information on this tab. See Figure 20. 

 
Figure 20. Options dialog box showing the Payer/Processor tab.  
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Section 5 Using the Software 
Now that all the necessary information to submit your transactions has been entered, you may 
begin using the software. This application appearance has been designed based on Windows. 
Each of the options at the top of the screen has the standard Windows options. The software has 
been enhanced to allow users to review each option through the Help feature. 

 Main Menu 

The icons under the menu titles represent each of the forms that may be submitted. Each of them 
is listed at the end of this section. You may also select Forms from the tool bar to select your form. 

 
Figure 21. Provider Electronic Solutions Main Menu 

From the menu you may select any of the options. They include the following: 

• File 

• Forms 

• Communication 

• Lists 

• Reports 

• Tools 

• Security Maintenance 

• Window 
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5.1.1 File 

The File menu item exits the application. You may also select the X box in the upper right-hand 
corner of the screen. 

 
Figure 22. Main Menu showing the File menu item. 
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5.1.2 Forms 

The Forms menu item allows you to open any of the transactions for entry. These are the same as 
the icons listed on the second line of the menu bar. 

 
Figure 23. Main Menu showing the Forms menu items. 
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5.1.3 Communication 

The Communication menu item allows for the following: 

• Submission transmits transactions to the Northeast Regional HIPAA Translator. 

• Resubmission resubmits a batch or copies the claims from a batch for editing and 
submitting. 

• View Batch Response allows viewing of downloaded responses to Eligibility Verification and 
Claim Status requests. 

• View 835 ERA allows viewing of the weekly Remittance Advice in an electronic format. 

• View Accept/Reject Claim Report – Functional Acknowledgement allows viewing of the 
DXC created report listing claims or files that were unable to be loaded into the system. 

• It also displays the Communication Log, which indicates the claim batch number and 
submission details. 

 
Figure 24. Main Menu showing the Communication menu items. 
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5.1.4 Lists 

The Lists menu item allows you to select from the available lists to enter or edit the information. 
The lists are described further in Section 5. 

 
Figure 25. Main Menu showing the Lists menu items. 
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5.1.5 Reports 

The Reports file menu item allows the printing of detail and summary reports for transactions and 
the contents of lists. Detail and summary reports may be printed for all the transactions. You may 
select one or more of the selection criteria to narrow the transactions to be printed. 

 
Figure 26. Main Menu showing the Reports menu items. 
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5.1.6 Tools 

The Tools file menu item allows for the following: 

• Archive allows you to archive old transactions or restore transactions that were previously 
archived. 

• Database recovery allows the user to compact, repair and unlock the database. 

• Get Upgrades allows you to dial into the web site to check for and download upgrades to 
the software. See Section 9 for instructions on downloading upgrades. 

• Change password allows users to change their passwords. 

For Options, refer to Section 3 – Basic Skills Signing On. 

 
Figure 27. Main Menu showing the Tools menu items. 
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5.1.7 Security 

The Security file menu item allows administrators to enter, update and remove users, their 
passwords and authorization levels 

 
Figure 28. Main Menu showing the Security menu item. 
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5.1.7.1 Adding a New User 

Each user should be assigned their own User ID and password. To add a new user: 

Step 1. Select Security and then Security Maintenance from the Menu Bar. 

Step 2. Assign a User ID unique to the individual. 

Step 3. Enter an initial password. The user will be required to change their password when they 
log into the system for the first time. 

Step 4. Enter the Authorization Level. A user with an Authorization Level of 2 User (Non-
Administrator) is allowed to enter, transmit, and download transactions and files. An 
Authorization Level of 3 Administrator is allowed the same security as a User, and is also allowed 
to enter, modify, or delete User IDs. The Security option will not appear on the menu of a person 
that is assigned the authorization level of 2. 

 
Figure 29. Assigning a security authorization level 
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5.1.8 Window 

The Window file menu item allows you to arrange the screens displayed. 

 
Figure 30. Main Menu showing the Window menu items. 

The Help function is described in Section 4. 
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Section 6 Provider Electronic Solutions (PES) Billing 
 List Function Overview  

The list function has been added to the software for two reasons. First, it allows a provider to 
enter information that is frequently used and then access this information in a transaction using a 
Drop-Down Data Window (DDDW) and second, it reduces the size of the transaction screens by 
requiring certain information to be entered into a list.  

There are many data elements included in the software that are required to generate a HIPAA 
compliant format. This is especially true of provider and client information. As a result, the 
Provider Electronic Solutions software requires that these lists be entered prior to completing a 
transaction. Additional lists include procedure code, diagnosis code, revenue center code and 
place of service.  

There are two lists that have been populated with data. They are Carrier, which lists the codes 
and names of other insurance companies and the Place of Service list. Both of these lists may be 
updated to add, delete or change the information to better serve your office. Please be aware 
that the codes listed are standard codes and may not be changed without notice resulting from 
HIPAA or DXC updates.  

The lists may be accessed from the Main Menu by selecting the List option or by double clicking in 
the appropriate field. This option allows a provider to add the information, as they need it, rather 
than requiring that all information be entered prior to keying a transaction. 

Once the information has been keyed into the list, it is available from the DDDW to populate the 
fields. Although not all of the information from the list will appear on the transaction screen, it will 
be used when formatting the HIPAA transaction prior to submission.  

Lists may be sorted by the row headers. The client list is sorted by selecting the Client ID, Last 
Name or First Name heading. Selecting the header one time will sort in ascending order. Selecting 
twice will sort in descending order. Upon opening, the Client and Provider lists are sorted by the 
ID number. 
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6.1.1 How to Enter a Provider 

Click on list and select provider 

 

• Provider ID/NPI - Please enter Group NPI  

• Provider ID/NPI Code Qualifier - Select XX  

• Taxonomy Code -  

• Entity Type Qualifier - Select 1 (person)   

• Last/Org Name - 

• SSN/Tax ID - Enter SSN 

• SSN/Tax IF Qualifier - Select 34  

• Line 1 - Provider address  
*This address cannot be a PO Box.  

• City - Town  

• State - State 
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• Zip - Zip Code  
*Must enter entire zip code including last 4 digits, if you don’t know the last 4 digits 
enter four zeros’ (as shown below).  

• Then click Save (right hand side) 

• Then click Add (right hand Side) 
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6.1.2 How to Enter Client 

Click on list and select Client 

 
 

• Client ID - Enter VT Medicaid’s UID number  

• ID Qualifier - Select MI  

• Account # - Your account number  
*It doesn’t matter what is recorded in this field, however there has to be something in 
this field.  

• Client SSN - Leave blank  
*Please do not enter the patient’s SSN number, because it’s not needed for the processing 
of the claim.  
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• Last Name - Patients last name  

• First Name - Patients first name  

• Clients DOB - Patient’s date of birth  

• Gender - select Female or Male  

• Line 1 - Address  

• City - Town  

• State - State 

• Zip - Zip Code  
*must enter entire zip code including last 4 digits, if you don’t know the last 4 digits 
enter four zero’s (as shown below).  

• Then click Save (right hand side) 

• If you have more clients to add then click add (right hand side). If no, then click close or the 
red X in the upper right-hand corner. 
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6.1.3 Adding a Diagnosis 

Click on list and select Diagnosis ICD-10 
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• Diagnosis Code - Enter your ICD-10 Diagnosis Code without the decimal point.  

• Description - Enter your description for the Diagnosis.  

• Then Click save (right hand side) 

• If you have more diagnosis codes to add then click add (right hand side). If no, then click 
close or the red X in the upper right-hand corner. If you are unsure about the diagnosis 
contact the provider for more detail. 
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6.1.4 Adding a Modifier 

Click on list and select Modifier 
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• Modifier Code -  UJ or TV 

• Description - Enter the description for the Modifier Code.  

• Then Click Save (right hand side) 
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6.1.5 Adding a Procedure/HCPCS Code 

Click on list and select Procedure/HCPCS 
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• Procedure/HCPCS T1002 for RN or T1003 for LPN 

• Description-Enter description of your procedure/HCPCS.   

• Then Click save (right hand side)  

• If you have more procedure/HCPC codes to enter, click add (right hand side). If no, then 
click close or the red X in the upper right-hand corner.  
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 Building your Claim 

Click on the Blue Medical symbol (837 Professional), on the main menu  

 
 

Now we can start building the claim. 
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6.2.1 HDR1 Tab 

Click the drop down on the field labeled provider ID/NPI and select your provider information. 
Then hit the tab button on your keyboard.  

*By hitting tab it will fill in the rest of the group provider information in. 

 

 

Click the drop down on the field labeled Client ID and select the patient you are trying to bill for. 
Then hit the tab button on your keyboard.  

*By hitting tab it will fill in the rest of the patient information in.    

 



 

2019-10-15 Hi-Tech Billing Guide 43 

That is all the information you need to enter into HDR1 tab.   

HDR1 should look like this: 

 
Now click on the HDR2 tab. 

6.2.2 HDR2 Tab 

Click the drop-down arrow next to the field labeled type and select 10 (ICD-10) 
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Now click the drop down next to field 1 and select the diagnosis code for the patient you are 
billing for.  

 
 

HDR2 should look like this: 

 
Now we can move to Srv1 Tab. Hdr 3 and Hdr 4 are not used. 
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6.2.3 Srv1 Tab 

Below are the list of fields that need to be completed, and what is required in each field:   

• From DOS - Enter your date of service then hit tab.  

• By hitting tab it will fill in the To DOS field.  

• To DOS - Enter your date of service  

• Place of Service - Select your place of service  

• Procedure -Select your CPT code  

• Modifier - Select the appropriate modifier.  

• Diag PTR - enter the number 1 

• Unit - Enter the total days/units you are billing  

• Billed Amount - Enter your total charge  

 

SRV1 should look like this: 

 
Now click on the SRV2 tab 
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6.2.4 Srv2 Tab 

Under the Rendering Provider section please select:  

• Provider ID/NPI - Select the individual provider who provided the service(s). Then hit tab 
on your keyboard  

* By hitting tab it will fill in the rest of the provider information in. 

 
 

SRV2 should look like this: 

 
Now click on the SRV3 Tab. 
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6.2.5 Srv3 Tab 

You do not need to enter any information on this tab. 

 
 

Now click Save on right hand side. If all the mandatory information has been entered the claim 
will save and bring you back to the HDR1 tab. 

If information is missing an error message box will pop-up, which looks like this.   

 
If this box appears, double click on the error and it will bring you to the field that needs to be 
corrected. Once the correction has been made, please click save on the right-hand side.  
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Once the claim is saved you will see it listed on the HDR 1 tab in R status at the bottom. That 
means the claim is ready to be submitted.  

 
 

 Submitting Claim(s)/Receiving Transactions 

Click on Communication on the main menu and select Submission. 
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Under “Files to send” select the bottom one that says 837 Professional.  
Then click submit on the right hands side. 

 
 

This screen will appear if the submission was successful.  

 

 

 

 

 

 

This screen will appear if the submission fails.  

 

 

 

 

 

 

 

 

 

Then unselect the 837 Professional under the “Files to Send” 
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Under “Files to Receive” select the bottom to reports name Claim Accept/Reject Report and 
Functional Acknowledgement Report. Once selected click submit.  

*Once the claims have been submitted they will be in F status meaning they have been submitted. 

 
 

The Claim Accept/Reject Report and Functional Acknowledgement Report should be retrieved 
after each submission of 837 transactions. The Functional Acknowledgement will inform you of 
the HIPAA compliancy of the submission. This report pertains to the HIPAA compliancy of the 
entire file. In cases of rejection, it is the entire file that is rejected, and the error must be corrected 
prior to submitting the file. The Claim Accept/Reject Report is claim specific for errors that 
prevents DXC from processing the claim. In this case, only the claim(s) listed on the report were 
rejected. The remainder of the claims were accepted for processing. 
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6.3.1 How to Copy Claim in F status 

When you go to bill again, you can copy the claim you previously submitted to make the process 
quicker. Then all you would have to do is change the dates of service, units and billed amount. 
Below are the instruction on how to copy a previously submitted claim.  

On the HRD 1 tab select the patient name of the claim you would like to copy.  

 
Then click copy on the right-hand side. 

*Once you click copy the “claim frequency” field will highlight blue   
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Now click on the SRV1 tab and change the Date of service, units, and billed amount, and any 
other changes you need to make.  

 

 

Once you have completed your changes/update click the save button on the right-hand side.  

The new claim will be listed at the bottom of the screen in R status. Which mean it’s ready to be 
submitted. 
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